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1. INTRODUCTION

1-1 About the Data Analysis Software

Welcome to the Ambulatory Blood Pressure Monitor (ABPM) Data Analysis Software (hereafter

referred to as “program”). This software is intended for use with the following monitors and
Processors.

1) A&D TM-2420/TM-2421 Ambulatory Blood Pressure Monitor {hereafter referred to as

“monitor”) and the TM-2020/TM-2021 Printer/Processor/Interface (hereafter referred to
as "processor").

2) A&D TM-2430 Series Ambulatory Blood Pressure Monitor (hereafter referred to as
"monitor")

The ABPM Data Analysis Software is a powerful tool for analyzing ambulatory blood pressure data.
The following features are incorporated in this program:

¢ Statistical Analysis Statistical data may be viewed in full, partial,
sieep, and awake periods by switching
between clearly labeled tabs.

4 Graphical Data Systolic/diastolic blood pressure, mean arterial
blood pressure, and pulse data are displayed
graphically to quickly determine patterns or
trends in the data.

¢ Data Conversion Data Convert feature automatically stores
blood pressure and pulse data in standard

(CSV) file format for use with popular
spreadsheet programs.

¢ Printed Reports Custom data reports formats are easily defined
and printed. "Mini-report” feature automatically
prints a compact summary report.

4 On-ine Help Built-in Help feature provides context-sensitive
help at any time. '
¢+ Maximum Time Period Doctor Pro uses up to one week’s data starting

from the oldest reading.
Delete the old data in the recorder.

¢ Maxdmumnumberofreadings A maximum of 896 readings can be
downloaded using Dactor Pro.

1-2 Symbols

The symbols printed on the device have the following meaning:

C € CE marking
SN Serial number



1-3 Monitoring Device Review

The following section briefly reviews the monitors and processors and how they may be used with this
program.

A&D Ambulatory Blood Pressure Monitors are used to record an individual's blood pressure over an
extended period of time, normally 24~72 hours. The monitor (TM-2420 Korotkoff, TM-2421 dual Korotkoff
and oscillometric, or TM-2430 series oscillometric) is worn by the patient. The monitor non-invasively
records the patient’s systolic/diastolic blood pressure an heart rate based on user defined intervals and
conditions.

The user may divide each 24 hour period into several time periods. Within each period the monitor may be
programmed to record the patient’s blood pressure at 5, 10, 15, 20?, 60 and 120 minute interval. The
monitor can also be programmed to remain OFF during any time period. These measurement intervals
may be timed to coincide with the patient’s daily activities.

The A&D TM-2020/TM-2021 Printer/Processor/Interface is used for performing one or more of the follow-
ing functions: Analyse blood pressure data stored in the monitor; program the monitor’s intervals and
conditions; function as an interface between the monitor and the program.

For those who do not want to utilise the Printer/Processor/Interface to analyse the blood pressure data
stored in the monitor, the program may be used in conjunction with an interface to retrieve the data stored
in the monitor. Data that was initially analysed using A&D TM-2020-01/02/03 or TM-2021-01/02/03 Data
Analysis Software for DOS™ Program is compatible with this program’s format and may be analysed by
this program.

1 The 20 minute measurement interval is available only with the TM-2421



1-4 Software Package Components

Items included in your complete software package are:
. CD ROM ‘Doctor Pro’

. Ambulatory Blood Pressure Monitor Data Analysis Software Instruction
Manual

. For TM-2420/21
AX-K0600 (9 pin D-SUB, socket type), Communication cable for TM-2420/
TM-2421

. For TM-2430 series
AX-KO1502 (9 pin D-SUB, socket type), Communication cable for TM-2430
series

1-5 System Requirements

. Computer A 486DX or higher microprocessor

. RAM memory Minimum of 8MB

. Operating System Windows™ ‘95, 98, NT 4.0

. Graphic Adaptor SVGA video card (minimum of 256 colours)

. Disk Type CD ROM Dirive

. Hard Disk At least 1.5MB available

. Serial Ports Minimum one (9 pin D-SUB or 25 pin D-SUB)

(A cable, separately available, is required for the 25 pin
D-SUB serial port)

. Printer Type Printers supported by MS Windows™ operating system



1-6 Software Installation

If you encounter a problem installing the program on your system or you believe that your software has
been damaged, contact your A&D office. Be sure to have the program’s serial number ready, located on

the CD label, when you call.

The program must be run from a hard disk drive only. It may not be run from the CD. To install the pro-
gram onto your hard disk drive, complete the following instructions:

Step 1 Insert the CD into your CD ROM drive. If you have Autorun installed then the program
will start automatically, otherwise click the START button on the Windows™ taskbar
and select Run. Type “D:setup” (This assumes your CD is in drive D: If necessary
substitute the correct drive number for D) and click OK.

Step 2 Follow the instructions on the screen

1-7 Safety

Do not attach the monitor to a patient when the monitor, or the monitor and the processor, are being
connected to the computer.



2. OPERATING PROCEDURE

2-1 Getting Started

Two initial actions may be executed when starting up the program:

(1) Data may be retrieved from the monitor.

{2} Stored data files may be opened and viewed for analysis.

To retrieve data from the monitor, see:

¢ "2-2 Communication Between the Monitor and the Program”

To view stored files, see:
¢ "“2-5-1 Open”

2-2 Communication Between the Monitor and the Program

To communicate between the monitor and the program, the connection between the monitor and the
computer must be established first.

2-2-1 Connecting the TM-2420/TM-2421 to the computer

¢ You must use the A&D-supplied RS-232C communication cable, otherwise
communication errors will occur.

¢ Steps 1-4 below must be completed prior to accessing the program or it may not
recogﬁize that the monitor is connected to the computer. If proper communication is not
established, a cable check error may occur.

¢+ You must use AX-KO600 cable for 9 pin serial port (supplied) or AX-KO599 cable for 25
pin serial port (available separately as an option).

TM-2420/21

To RS-232C (—————u

/ Personal computer

TM-2020/21 RS-232C communication cable

Figure 3: Connection between the TM-2420/2421 and the computer
{(The illustration above is not to scale.)
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Step 1
Step 2

Step 3

Step 4

Connect the monitor to the processor.

Connect the male end of the A&D-supplied RS-232C communication cable to the
processor.

Connect the female end of the A&D-supplied RS-232C communication cable to the
computer.

The display on the processor wilt show “0-----". If the processor does not have a
display, the LED should be green. If the LED is not green or the “0-----" does not
appear, see "3-2 Communication Errors”. If the processor shows “0-----", go to step
5. If the processor has a green light, go to step 6.

Note: If possible, keep the cable connected to the computer unless the port is needed

Step 5

Step 6

Step 7

for other functions.

Press the ENTER key on the processor keypad. A series of 6 dashes “----—- * will
appear on the processor screen.

Run the program.

Confirm that the correct serial port is set. For details, see “2-9-4-2 Serial Port".

2-2-2 Connecting the TM-2430 series to the computer
¢ You must use the A&D-supplied RS-232C communication cable, otherwise

communication errors will oceour.

-

¢ You must use AX-KO1502 cable for 9 pin serial port (supplied) or AX-KO1503 cable for
25 pin serial port (available separately as an option).

Step 1

To RG-232C

]

—m\
{ Personal computer

RS$-232C communication cable

L~

TM-2430 series

Figure 4 : Connection between the TM-2430 series and the computer
{The illustration above is not to scale.)

Connect the male end of the A&D-supplied RS-232C communication cable to the
monitor.



Step 2 Connect the female end of the A&D-supplied RS-232C communication cable to the
computer.

Step3 The display on the monitor will show “--". If “--" does not appear, see “3.2
Communication Errors”. Otherwise go to step 4.

Note: If possible, keep the cable connected fo the computer unless the port is needed
for other functions.

Step 4 Run the program.

Step 5 Confirm that the correct serial port is set. For details, see “2-9-4-2 Serial Port”.

The system is now ready to:

Retrieve data from the monitor. See “2-7-1 Retrieving Data from the Monitor”.

Clear the monitor's memory. See “2-7-2 Clearing the Monitor’s Memory”.

Program the monitor's intervals and conditions. See "2-7-3 Programming the Monitor’s
Intervals and Conditions”.



2-3 Main Screen Description

The main screen is comprised of six menus and two toolbar butions located permanently along the

top of the screen. These menus may be used to access the various features of the program. The

toolbar buttons may be used to set Partial Analysis and Blood Pressure Mode parameters,

Toolbar Buttons:

Button See

Description

Analysis Intervals

“2-4-1 Analysis Intervals”

The Analysis Intervals button may be used
to define specific “Full” and “Partial” time
periods within an opened data file for
custom data analysis.

BP Mode “2-4-2 BP Mode”

The BP Mode (Blood Pressure Method)
selection box may be used to specify which
blood pressure measurement method
(Korotkoff, oscillometric or both) is used as
the basis for statistical and graphical
analysis.

Note: This only applies to TM-2421 data
files.

Main Menus:

Menu See

Description

File “2<5 File Menu”

The File menu may be used to manage the
files stored on the hard drive or a disk and to
exit the program.

View “2-6 View Menu”

The View menu may be used to access the
statistical, tabular, and graphical analysis
screens.

Recorder "2-7 Recorder Menu”

The Recorder menu may be used to
program the monitor, clear measurement
data in the monitor's memory and to retrieve
the measurement data in the monitor.

Report “2-8 Report Menu”

The Report menu may be used to specify
report formats and print reports.

Option “2-9 Options Menu”

The Option menu may be used to set the
default settings and user-defined
parameters.

Help ‘2-10 On-line Help”

The Help menu may be used to view
information on program usage. Help may
also be accessed by pressing F1 when
various screens are opened or by selecting
the Help button on a screen.
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2-4 Toolbar

There are two toolbar buttons which appear underneath the main menu bar-

(1) Analysis Intervals
{2) BP Mode

2-4-1 Analysis Intervals

The Analysis Intervals feature may be used to define specific periods of time within an opened data
file for custom data analysis. Two periods, Full Analysis and Partial Analysis may be defined for
each data file. The Partial Analysis Interval settings are displayed on the toolbar.

Adjust the Full Analysis times to change the start and end times for data analysis.
Enable and set the Partial Analysis Interval to define a sub-interval within the Full Analysis interval.

For example, you may wish to test a 12-hour drug dosing window to check for pharmaceutical
related peaks and troughs within the patient’s circadian rhythm,

Analysis Intervals [x]

Recoded hom: 1300 050991 I
i FULL ANALYSIS INTERVAL - - -
Time

: Stat {77 i

— PARTIAL ANALYSIS INTERVAL —
{ Stayg e Time Date

| ¥ Disebed sat [57y [Feon {77 ]
e s} Oustliore [T Houag o T

soe | cood | teb - |

Figure 5: Analysis Intervals dialog box

The Partial Analysis Interval affects many of the program features including:

4 Summary Data

After the Partial Analysis Interval is enabled, the Partial tab in the Summary Data will be
activated.

¢ Trend Graphs

After Partial Analysis Interval is defined, the data specified within the parameters wili
appear in red on the Trend Graph.

+ Histograms

After Partial Analysis parameters are defined, the data specified within the parameters
will appear in red overlaying the Full Analysis data.

¢ Correlation Plots
After Partial Analysis parameters are defined, a second set of Correlation Graphs in red

will appear based on the data specified within the Partial Analysis parameters.

1



2-4-2 BP Mode

The BP Mode is used to select which blood pressure method will be used as the primary and
secondary choices for dispiaYing the blood pressure measurement data. A&D monitors employ
either Korotkoff, oscillometric or dual Korotkoff and ocscillometric measurement methods. |If the

current data file contains data from a dual system, you may choose Korotkoff, oscillometric or both
methods to analyze the data.

The measurement method(s) specified in the BP Mode will be the basis for the statistical and
graphical analysis performed on the opened data file. The method noted with a one (1) is the
primary method and the method noted with a two (2) is the secondary method. If a primary method
measurement error occurred during the monitoring session or a measurement is manually excluded
(see "2-6-2-1 Excluding/Including BP Measurements’), a valid measurement in the secondary
method will be substituted for it with the appropriate BP Mode selection.

Method Setting Description

Oscillometric only This option sets the primary blood pressure choice to
oscillometric and disables the secondary choice. If the
oscillometric reading for any measurement is invalid or has
been excluded by the user in the BP Data List, the
measurement will be excluded from graphical displays and
statistical computations.

1: Oscillometric, 2: Korotkoff This option sets the primary blood pressure choice to
oscillometric and the secondary choice to Korotkoff. If an
osciliometric reading is invalid, oscillometric readings will
be substituted with Korotkoff readings. If both readings
are invalid for a measurement, all data from the
measurement is excluded.

Korotkoff only This option sets the primary blood pressure choice to
Korotkoff and disables the secondary choice. If the
Korotkoff reading for any measurement is invalid or has
been excluded by the user in the BP Data List, the
measurement will be excluded from graphical displays and
statistical computations.

1: Korotkoff, 2: Oscillometric This option sets the primary blood pressure choice to
Korotkoff and the secondary choice to oscillometric. If a
Korotkoff reading is invalid, Korotkoff readings will be
substituted with oscillometric readings. |f both readings
are invalid for a measurement, all data from the
measurement is excluded.
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To specify the BP Mode while viewing an opened data file, complete these steps:

Step 1 Select the BP Mode box on the toolbar.
Step 2 Select the desired BP Mode used to view and analyze the opened data file.

|1:K0mtk0ff, 2.0scillometric '_'j

Oscillometric only
1:Oscillometric, 2-Korotkoff
Korotkaff onl

Hokorotkoft. 2 Osciloretie

Figure 6: BP Mode selection on toolbar

To set a default BP Mode for the program at startup, see “2-9-4 Detauit Settings”.

Note: The BP Mode for printed reports is assigned separately in the Report Format

Setup. See “2-8 Report Menu”.

2-5 File Menu

The File menu is used to manage the files stored on a hard drive or floppy disk. It may also be used

to exit the program. The File menu has the following sub-menus:

Menu Description

Open This function is used to select a data file for viewing, modifying or
printing a report. After a file has been opened, the file name, patient
name and date of the monitoring session are displayed in the title bar
of the main screen

Save As This function is be used to copy a selected file to a new file with a
different name.

Delete This function is used to delete a selected file.

Convert This function is used to convert the blood pressure measurement
data of a data file to a format which is readable by most spreadsheet
applications. The converted file will have the same name as the data
file with a .CSV file extension.

Print This function is used to print reports for one or more data files
according to a user-selectable report format.

Exit This selection may be used to exit the program.

13




2-5-1 Open

The File | Open function is used to access the blood pressure data within existing data files.

Locki |2 Date Fies 3] =

#]Demol. dat

Fie name: | | Dpen j
Files of type:  [BP data fies (* dat Rd Cancel |

Figure 7: File Open dialog box

To open a file, complete the following steps:

Step1 Select the File menu.
Step2 Select the Open sub-menu.

Step 3 Select a file from the directory shown or move to a different directory.
Step 4 Click the Open button.

Note: The File | Save As, View and Report menus and Analysis Intervals buttons are
disabled until a data file is opened.

2-5-2 Save As

The File | Save As function is used to copy an open data file to another data file with a different
name or {o a different directory with any name.

When a file is copied, corresponding .dat and .P files are created. These two files must stay together
within the same directory. The Save As function creates new .dat and .P file with the new file name
in the selected directory. When entering a new file name in the Save As dialog box, it is not

necessary to type the file extension. The original file will not be altered when using the Save As
function.

2-5-3 Delete

The File | Delete function is used to delete a data file.

CAUTION: Data files will be permanently removed when deleted.
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2-5-4 Convert

The File | Convert function is used to create a .CSV (comma delimited) format file from a .dat file
that is compatible with most spreadsheet applications, including Microsoft Excel™. The .CSV file
that is created includes DATE, TIME, SYS, DIA, PUL, ERR headings so that the data can be
identified correctly when opened in a spreadsheet. The original file will not be modified in any way.

The data is being converted and will be saved to the same name and directory as the original data
file, but with a .CSV extension.

2-5-5 Print
The File | Print function is used to print reports for one or more data files according to a user-

selected format. This enables the user to generate multiple reports without having to open each file
separately and selecting a report.

To print a report for multiple data files, complete the following steps:

Step 1 Click the File menu, then Print.

Step 2 In the Print dialog box, select the files that you want to print a report for by holding
the Shift or Ctrl key down while clicking the desired files.

Step 3 Click Open.

Step 4 In the Report Selection dialog box, select the report format that you want to use for
the reports or click Print “Mini” report to print a condensed report.-

2-5-6 Exit

The File | Exit selection may be used to exit the program.

2-5-7 Saving a File
Files are automatically saved when the data is retrieved from the monitor. See “2-7-1 Retrieving

Data from the Monitor”. Any modifications made to the data file are saved immediately when the
Save button is selected to close a function.

2-5-8 Closing a Data File

There is no file close feature in this program. A file may be ciosed in two ways:

1) By opening another file. The current file will automatically be closed when you open
another file.
2) By exiting the program.

15



2-6 View Menu

The View menu may be used to view numerical, statistical and graphical data screens. The View

menu is disabled unless a file is opened. For information on how to open a file, see "2-5-1 Open”.

The View menu has the following six sub menus:

Menu See Description

Summary Data “2-6-1 Summary Data” Function for viewing statistical data.

BP Data List “2-6-2 BP Data List” Function for viewing numerical data and
entering comments.

Trends ‘2-6-3 Trends Screen” Function for viewing blood pressure, mean
arterial blood pressure, pulse (heart rate) and
double product Trends.

Correlation “2-6-4 Correlation Plots” Function for viewing correlation plots of
Systolic Blood Pressure to Diastolic Blood
Pressure and Diastolic Blood Pressure to
Pulse.

Histograms “2-6-5 Histograms” Function for viewing the frequency distribution
of the measurement data.

Patient Information | “2-6-6 Patient Information” | Function for entering patient and physician

: information, as well as fields for the sleep and
awake periods.

2-6-1 Summary Data

The Summary Data screen includes statistics on the data of the opened file and may be viewed
directly on the screen. These statistics are separated into four data tabs:

Full

Statistics based on all the data within the file.

Partial Statistics based on the data specified within in the Partial Analysis parameter. See

‘2-4-1 Analysis Intervals”.

Awake Statistics based on the data during the waking hours.

Note: Waking hours are specified as those hours outside the identified sleeping hours.
Sleep Statistics based on the data during specified sleeping hours. See “2-6-6 Patient

Information”.

To view, close, or print the individual Summary Data screen, complete the following steps:

Step 1 Click the View menu.

Step2 Click Summary Data. The Summary Data display appears.
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Figure 8: Summary Data display

Step 3 Click one of the four data tabs, Full, Partial, Awake or Steep. The Full tab will always
be enabled. The Partial, Sleep and Awake tabs will be enabled after they are
specified. See “2-4-1 Partial Analysis” to specify Partial Analysis and “2-6-6
Patient Information” to specify the Sleep pericd.

Step 4 To print an individual Summary Data tab, select the tab you want to print and select
the Print button on the right hand side of the screen.

Note: You may also print the Summary Data screens in the standard report, see ‘2-8
Report Menu”.

Step 5 Close the Data Summary screen when finished.
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Each of the four Summary Data tabs is titled with the name of the tab, file, patient and measurement
method. For detailed information on Summary Data screen listings, see below:

Summary Data Tab

Definition

Time Interval

The analysis period, start time/date — end time/date, for the
activated Summary Data tab.

Valid Readings

The total number of measurements taken during the monitoring
session less any monitoring errors or manually excluded readings
within the data set. See “3-1 Measurement Errors” for
information on measurement errors.

Excluded Readings

The measurement error percentage. This figure is based on the
combined total of measurement errors and excluded
measurements.

Min {(Minimum)

The minimum measurement value for Systolic, Diastolic, MAP
and Pulse measurements during the Time Interval.

MAP

{Mean arterial blood pressure)

The mean arterial blood pressure value of the measurements for

Systolic, Diastolic and Pulse measurements during the Time
Interval.

Max (Maximum)

The maximum measurement value for Systolic, Diastolic, MAP
and Pulse measurements during the Time Interval.

SD (Standard Deviation}

The Standard Deviation of the measurement value for Systolic,
Diastolic, MAP and Pulse measurements during the Time
Intervai.

SE (Standard Error)

The Standard Error of the measurement value for Systolic,
Diastolic, MAP and Pulse measurements during the Time
Interval.

CV(%)
(Coefiicient of Variation )

The Coefficient of Variation for Systolic, Diastolic, MAP and Pulse
readings during the Time Interval.

SYS Values

The percentage of the Systolic measurement values greater than
the specified Systolic limit. See “2-9-4-1 BP (Blood Pressure)
Settings" for information on specifying the Systolic Blood
Pressure Limit.

DIA Values

The percentage of the Diastolic measurement values greater
than the specified Diastolic limit. See "2-9-4-1 BP (Blood
Pressure) Settings" for information on specifying the Diastolic
Blood Pressure Limit.

Highest Systolic Value

The time and date of the highest Systolic value during the Time
Interval.

Highest Diastolic Value

The time and date of the highest Diastoiic value during the Time
Interval.

Lowest Systolic Value

The time and date of the lowest Systolic value during the Time
Interval.

Lowest Diastolic Value

The time and date of the lowest Diastolic value during the Time
Interval.

18




2-6-2 BP Data List
The BP Data List function displays individual blood pressure measurement within an open data file in
tabular form. With the BP Data List, you may input measurement comments, exclude/finclude a

measurement within the graphics and statistics or link a measurement to the beginning of the Trend
screen.

The following table defines each heading within the Blood Pressure Data List:

item Description
NO. Measurement number
DATE/TIME Date and time of the measurement
SYS Systolic blood pressure
DIA Diastolic blood pressure
MAP Mean arterial blood pressure
PUL Pulse
DP SYS* PUL
Double Product, equals ————
100
STATUS The status line has 4 positions. When filled with a character other than “—",
each denotes a specific occurrence or condition.
Position 1 | Denotes the BP method used for the specific measurement. ‘K’ refers to
BP method, | Korotkoff method, “O" refers to oscillometric method.
OorK
Position 2 | Indicates that data was measured when the monitor's EVENT button was
E (Event) activated.
Position _3 | Denotes the specific error code that occurred during the monitoring session,
Error code see “3-1 Measurement Errors”.
Position 4 | When this position 4 has an “X”, the measurement has been excluded from the
X~Exclude- | statisiics and graphs.
Comment Space provided for user to enter patient diagnostic notations up to 20
characters.
Vertical  scroll | The vertical scroll bar on the right hand side of the screen helps scroll through
bar the measurements. This may also be performed with the up and down arrow
keys, as well as the mouse.
Save button Saves any edits, i.e. comments, exclusions or inclusions.
Close button Closes the screen.
Note: Edits (comments, exclusions or inclusions) will not be saved.
Help button Opens the Blood Pressure Data List help screen.

19




t DATE_JTME fsvs o [M&P. [PUL- [OP . |sTATUS|BXCLUDE [COMMENTS iii

1 |89 1300 152 103 199 78 118 D~ .

2 |05/ 1315 154 8 N7 W% U3 0--

3 BA 12 1% 8 1 73§ 0.-

45 |SO%/91 1345 140 101 14 7 103 D--

B 0509/ 400 145 W02 TE 7B 113 0.

B A9 415 13 S 108 M 10 0-- X teisei

7 05/03/91 1430 150 97 114 79 7 a--

i 05/09/91 14:45 133 97 m 0N 25 0.

4 (Emmiism s w0 14 @ 2 o

10 {05991 1595 47 M2 23 @ 12 p--

1M Jo50%91 153 153 106 121 78 M8 Q.-

121050991 1545 47 11F 123 ™ w8 Q-

13 jemem B0 124 15 1M % 132 0--

14 |05/09/91 1615 8 115 1% B 15 0.- =
s | Cose | Hee |

Figure 9: Blood Pressure Data List display

2-6-2- 1 Excluding/including BP Measurements

It is useful to exclude a measurement from the Blood Pressure Data List in cases where the
measurement is clearly incorrect. The program provides a simple way to include or exclude
measurements while viewing a list. When a measurement is excluded from the Blood Pressure Data

List, it will not be included in any of the program’s statistical or graphical analysis functions.

A measurement can be included or excluded by clicking on the measurement in the column labeied
Exclude. An “X" in the Exclude column indicates that the measurement is excluded. A “"indicates
that the measurement is included.

In some cases the program automatically excludes measurements if an error occurred during the
reading. Measurements that have been automatically excluded are displayed with and “X” in the
Exclude column and cannot be included by the user.

Note: Measurements that have been excluded are not deleted from the data file.

2-6-2- 2 Entering Comments
Comments, such as information taken from the patient activity diary, may be entered into the data
file. To enter a comment, complete the steps below:

Step 1 Click the measurement in the column labeled Comments.
Step 2 Type your comment — maximum 20 characters.,

Note. You may write over any of the automatic measurement error comments.
Step 3 Press the Enter key or click a different measurement to store the comment.

Step 4 To save the comments, click the Save bution before closing the Blood Pressure Data
List screen.

Step 5 Click the Close button if you do not want to save the comments.
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2-6-2- 3 Linking to Trends Screen

A measurement may be linked to the Trend Graph by highlighting an individual measurement and
then closing the Blood Pressure Data List. When opened, the Trend screen will be aligned with the
time of the highlighted measurement in the Blood Pressure Data List. This feature may be used to
pinpoint the position of an individual measurement on the Trend Graph.

2-6-3 Trends Screen
The Trends function is used to visualize trends in a patient’s blood pressure, pulse, MAP and DP

calculation over time. The Trends screen is a useful diagnostic tool to determine nocturnal dips and
related peaks and troughs in the patient’'s circadian rhythm.

The Trends function provides graphic representation of the data file. The Trends function is
dependent on the following parameters:

Partial Analysis
BP Mode (Measurement Method)
Sleep Period

* * + o

Blood Pressure Limits
The following four trends can be displayed in the Trend function:

4 Systolic/Diastolic Blood Pressure (BP Trend) and Pulse {Pulse Trend):
The vertical axis represents millimeters of mercury (mmHg) and the horizontal axis
represents time. A vertical dotted line connects the measurement’s systelic and diastolic
pressures. This line may Ee used to estimate the pulse pressure?.

L Fia-te, Pulse (Puise Trend):
The vertical axis represents beats per minute (BPM) and the horizontal axis represents
time.

+ Mean Arterial Blood Pressure (MAP Trend):
The vertical axis represents millimeters of mercury {(mmHg) and the horizontal axis
represents time. The MAP Trend may be displayed on its own or in combination with the
BP Trend. If the MAP Trend is combined with the BP Trend, it will appear between the
Systolic and Diastolic Trend lines.

+ Double Product:

The vertical axis represents millimeters of mercury (mmHg) and the horizontal axis
represents time.

2 The Pulse Pressure is the difference between the Systolic and Diastolic blood pressures.
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Delimitation, Scroll Bar and Linking

L 4 Partial Analysis:
When the Partial Analysis feature is enabled, red bands will appear on all the Trend
Graphs highlighting the petiod and data specified within the Partia} Analysis parameters.

¢ Sleep:

. When the Sleep period is identified, black bands will appear around all the Trend
Graphs highlighting the specified Sleep period.

L Blood Pressure Trend BP Limits:
When the Systolic and Diastolic Blood Pressure Hypertensive Limits are specified, lines
are drawn horizontally across the Biood Pressure and Mean Arterial Blood Pressure
trends at the specified limits. These lines may be used to determine when the patient
exceeds the user defined limits during the monitoring session.

¢ Scroll bar/Linking:
The scroll bar at the bottom of the Trends dispiay allows you to scroll through the Trend
Graphs. You may also link the Trend display to the Blood Pressure Data List by aligning
the left hand side of a Trend screen with the vertical line of an individual biood pressure

measurement.  When the Blood Pressure Data List is displayed, the aligned
measurement will be selected.

BR+ DP

Select Zoom Prnt
P PULSE
Ay 280 oo BE TAR PO L P r
BPM
2401 - r
2004+ L
160 4.
140
1za — 1z0
50
80 dusavs? Toggieeq oot i w1 SR P L A e T ey = .
PrY o
. =0
200 - (maltg BIHI/LOR _DOUALE FRODUCT
500
400
300
200
1c0
o SLRED
PAPTIAL ANALYSIZ
13 34 15 16 17 18 19 20 21 22 23 0 1 2z & 4 5 & 7 8 9 10 11 12 13 la
. Demol = 0ss03/3% L S X
il 2

Figure 10: Trend display with all positions specified

The Trends display can be modified in two ways:

(1) Trends selection
{2) Scaling

Once you have opened and selected a data file, foliow the steps below to view, scale, customize and
print the Trends screen.
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2-6-3- 1 Viewing the Trends

Step1 Select the View menu.
Step 2 Select the Trends sub menu.

Step3 You may print the Trends screen by selecting the Print heading on the Trends toolbar.
Step 4 Close the Trends screen when finished.

2-6-3- 2 Scaling the Screen

The Trends screen may be scaled to have some or all of the data fit on the screen. To scale the
Trend screen, complete the following steps:

Step 1 Select the Zoom drop-down menu on the Trends toolbar.
Step 2 Select a scale to view the screen: All data, 1, 3, 6 or 12 hours.

2-6-3- 3 Trend Display: Positioning Trends
The Trends screen may be customized to show one or more trends on the screen simultaneously in
any order. The trends positions may be set to:

Blood Pressure: Systolic/Diastolic or MAP, Pulse
Double Product

] Blank: When a position is set to Blank, the other specified trends will expand to fit the
screen.

Trend Page Selection ]

Trend Page List

IBF + DP

Full Hew...

Standard
Edit..
Delete

0K

Cancel

Figure 11: Trend Page Selection dialog box
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To customize the Trends screen, complete these steps:

Step1 Click the Select button on the top left hand comer of the Trends toolbar.

Step2 Highlight the Trend Page Template you want to view and click the OK button or
double click the Trend Page Template.

If an existing template does not meet the requirements, you may create a new template or edit an
existing one.

2-6-3-4 Creating a New/Edit Trends Template

The new and edit Trend Page features are quite similar. The instructions for these features have
been combined.

Trend Page Setup . . ' I
Page Name:
Position 1: Biood Pressure. {
Position 2: Double Product l Save i
Position 3; (Blark) ' Lancel |
Posiion 4 Blark | _teb |

Figure 12: Trend Page Setup dialog box

Step 1 To create a new Trend template, select New and go to step 2.
To edit a Trend Page, go to step 3.

Step 2 Input a name for the New Trend Page and go to step 6.
Step 3 Highlight the Trend Page template you want to edit and select the Edit button.
Step 4 Enter a name for the Trend Page.

Step 5 Select Position 1.

Step 6 Select the Trend to reside in Position 1. The position will be set with the specified
trend.

Note: There are two sub trends to the Blood Pressure Trend: 1) Systolic/Diastolic 2)
MAP.
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Figure 13: Blood Pressure Trend Setup dialog box

Step 7 Repeat steps 5-6 to set positions 2, 3, and 4.

Step 8 To save your trend template, click the Save button
Step 9 To cancel the operation, click the Cancel button .

2-6-4 Correlation Plots

The Correlation screen offers a convenient way to view the relationship between the Blood Pressure
parameters. it also assesses overall performance of the patient's cardiovascuiar system. Both Fuli
and Partial Analysis Correlation Plots may be viewed for the following relationships:

1)  Systolic versus Diastolic
2)  Systolic versus Pulse (Heart Rate)
3}  Statistical Data® Systolic, Diastolic, Puise
- Mean, "m"
— Standard Deviation, "s"
— Correlation Coefficient, "r"
— Regression Line

The vertical axis represents systolic pressure, the horizontal axis represents the diastolic pressure
on the right hand graph and pulse on the left hand graph. All the graphs have scales of 0 to 300
mmHg.

Note: If Partial Analysis is enabled, four graphs will appear. The first two graphs on the
left hand side of the screen, in blue, are based on Full data. The second pair of
graphs, in red, on the right hand side of the screen is created from valid data
specified within Partial Analysis parameters.

Each measurement recorded represents a dot on the screen. The vertical position of the dot is equal
to the systolic value on both graphs. The horizontal position on graph 1 is equal to the diastolic value

and on graph 2, the pulse. The clusters of dots are created by the overlapping of recorded

3 Statistics and graphs are effected by the deleting and inserting of measurements in the BP
Data list.
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measurements. Measurement statistics, Mean Systolic blood pressure 'm", Standard Deviation "s",

Regression Line and Correlation Coefficient “” values are shown on the bottom of the screen.
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Figure 14: Correlation Plots display
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2-6-5 Histograms
The Histograms screen offers a convenient way to quickly review the overall magnitude and

distribution of the systolic, diastolic, mean arterial blood pressures and pulse (heart rate)
measurements. The following Histograms are available:

* Systolic Blood Pressure:
Full Analysis in blue, Partial Analysis overlaid in red.

¢ Diastolic Blood Pressure:
Full Anaiysis in blue, Partial Analysis overlaid in red.

L 4 MAP, Mean Blood Arterial Pressure:
Full Analysis in blue, Partial Analysis overlaid in red.

* Double Product:
Full Analysis in blue, Partial Analysis overlaid in red.

* Pulse:
Full Analysis in blue, Partial Analysis overlaid in red.

¢ Statistical Data*:

MAP and SD for: SYS, DIA, MAP, DP and HR. Full Analysis is in blue, Partial Analysis
in red.

The vertical scale represents 0 to 300 mmHg on all graphs except Pulse which is scaled 0 to 250
BPM. The horizontal scale represents the percentage of total readings that occurred at the

corresponding vertical level. The Histograms are displayed in blocks that represent a range of
readings. )
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Figure 15: Histograms display

4 Statistics and graphs are effected by the deleting and inserting of measurements in the BP
Data fist.
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2-6-6 Patient information

The Patient Information screen is used to store information on patients and their treatment. This is

also the input screen for the patient’s Sleep period.

Patient Information [ >}
Recoeder 1D: 1 Date: 05/09/91 Time: 13:00
Fie Demol Soc. Sec. #: ’ Age: l_““
Name. [Demd Insurance: Sex: E :
Addiess: Heght l_—
Medicare §: I Weight: l
P . [__._.__........._ Medications: l
Comments:
PHYSICIAN List ]
Mame: I_.........._..............._
Address: l_——
SLEEP Begin End Save
Ew - [ L
_fened |

Figure 16: Patient Information display

The Patient Information screen has the following data fields:

(The characters referred to in the table below include CRs and spaces.)

Field

Description

Recorder ID

Recorder ID refers to the monitor identification number. The Recorder ID
cannot be modified in this screen. It is established during the monitor setup
prior to the monitoring session. See “2-7-3. Programming the Monitor’s
Intervals and Conditions”.

Date

Date corresponds to the first measurement date in the patient record. Date
cannot be modified in this screen. It is automatically set at the time the
measurement was recorded.

Time

Time corresponds to the first measurement time in the patient record. Time
cannot be modified in this screen. It is automatically set at the time the
measurement was recorded.

File

File refers to the name of the file. It is initially defined by the user at the time of
data retrieval.

Name

There are two name fields. Enter up to 20 characters for the patient name
when the data is retrieved. Selecting this field allows changes to the patient
name. Enter up to 60 characters for the physician name. The physician’s name
may be entered automatically by selecting the List button. See “2-9.2
Physician List”.

Address

There are two address fields. The patient address field may be filled in
manually. The physician address field may either be filled in manually, or
automatically by selecting the List button. See “2-9-2 Physician List".
Up to 50 characters can be used for each address field.

Phone

There are two telephone fields. The patient phone field may be filled in
manually. The physician phone field may either be filled in manually, or
automatically by selecting the List button. See “2-9-2 Physician List".

Up to 20 characters can be used for each phone field.

Soc. Sec. #

Field for the patient's social security number. Up to 20 characters can be used.

Insurance

Field for the patient's insurance information. Up to 40 characters can be used.
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Field Description

Medicare # Field for the patient's Medicare or Medicaid number or other health care
number. Up to 20 characters can be used.

Medications Field for the patient’s medications. Up to 60 characters can be used.

Age Field for the patient’s age. Up to 10 characters can be used.

Sex Field for the patient’s sex. Up to 10 characters can be used.

Height Field for the patient’s height. Up to 10 characters can be used.

Weight Field for the patient's weight. Up to 10 characters can be used.

Comments Field for comments on the patient's condition, treatment or other notes. Up to
400 characters can be used.The scroll bar will automatically be activated when
additional space is required.

Sleep The Sieep field is used to define the sleep parameter. Begin refers to the time
the patient went to sleep. End refers to the time the patient woke up. The 24-
hour clock must be used when inputting the sleep times. For example, 11 p.m.
equals 23:00, Midnight equals 0, and 9 a.m. equals 09:00. Use a colon ""
between hours and minutes.

Follow the instructions below to view, edit and print the Patient Information screen.

Step 1
Step 2
Step 3
Step 4
Step 5

Select the View menu.

‘Select Patient Information sub menu.

To edit a field, select the appropriate field and input the information.
To save the edits and close the Patient Information screen, select the Save button.

To cancel the edits and close the Patient Information screen, select the Cancel
button.

Note: For some types of printers, the number of printed characters may be different from

the number of displayed characters.

2-7 Recorder Menu

The Recorder menu may be used to retrieve data from the monitor, set the monitor's intervals and

conditions and clear the data in the monitor's memory. With the monitor and the processor
connected to the computer, the following options are provided:

1)  Retrieve data
2)  Condition setup
3} Clear data

Note: If communications cannot be made due to improper connection or some other

faifure, see "3 TROUBLE SHOOTING”
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2-7-1 Retrieving Data from the Monitor

Recorder - Retrieve Data %] I
Recorder ID: 1
Start Date; 03/25799
Start Time: 12:56
Patient Name: l[

r~ Conwvert Data
: ¥ Create CSV file automatically

Retrieve data

Status: Connected

Read couinter:

Figure 17: Recorder-Retrieve Data dialog box

See below for the description of each field on the Recorder-Retrieved Data dialog box.

Field Description

Recorder ID Recqrder ID is set in the monitor's memory prior to the monitoring
session.

Start date Date of first measurement in the monitor's memory.

Start time Time of first measurement in the monitor's memory.

Patient Name

Field for the patient’s name.

Convert Data -

Creates a CSV file automatically when checked.

Status

Status line offers comments on the present stage of the data retrieving
process, e.g. “connected” or “retrieving data”.

With the monitor and the processor connected to the computer, you may retrieve data from the

monitor by completing the steps below:

Step 1 Select the Recorder menu.

Step 2 Select Retrieve data sub menu.

Step 3 Select the Patient name field and input the patient's name. The name will appear in

the Name field on the Patient Information screen.

Note: You must input a patient name or the data can not be retrieved. To exit the
Retrieve Data dialog box prior to retrieving the data, select the Windows™
function box in the top left corner of the Recorder—Retrieve Data dialog box.

Step 4 Select the Retrieve button.
Step 5 Select the File Name field and enter a file name.
Step 6 Select the Drive and Directory where the file should be saved.
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Step 7- Select the OK button.
Note: To view a retrieved file, you must open it.

2-7-2 Clearing The Monitor’'s Memory
The monitor's memory should be cleared before each monitoring session. With the monitor and the

processor connected to the computer, you may clear the measurement data stored in the monitor by
completing the steps below:

Step 1 Select the Recorder menu.
Step 2 Select Clear data sub menu.

Recorder - Clear Data I

This wall clear all data in the recorder!!

Figure 18: Recorder - Clear Data dialog box

Step 3 To clear the monitor's memory, select the OK button.

Step 4 To not clear the monitor's memory, select the Cancel button.

CAUTION: Cleared data cannot be recovered.
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2-7-3 Programming the Monitor’s Intervals and Conditions

2-7-3-1 TM-2420/TM-2421 Setup

With the monitor and the processor connected to the computer, you may setup or change the

following monitor condition and interval settings:

ltem

Definition

Recorder ID number

Recorder (or patient) ID number (01 through 99). This is useful
when more than one monitor is used in the same clinical setting.

Time Sets monitor's internal clock.

Date Sets monitor’s internal calendar.

Display ON/OFF Turns the monitor display ON or OFF during automatic
measurement session. It may not be desirable for the patient to
see the measurement results. Some patients become nervous
when they see the measurement resuits. This may affect their
blood pressure readings.

Buzzer ON/OFF Sets whether or not the monitor will beep 10 seconds prior to the

start of a measurement.

Time

Interval

Automatic measurements

A 24-hour day may be broken up into 4 periods. For a more
detailed explanation, see monitor's instruction manual.

The Time of the first (1) period is the start and end time of the
monitoring session.

The Time of the second (2) period, if set, is the start of the
second period and end of the first. The Time of the third (3)
period, if set, is the start of the third period and end of the
second. The Time of the fourth (4) period, if set, is the start of
the fourth peried and end of the third.

Note: You do not need to program all periods.

The Interval is the number of minutes between each
measurement within the specific period.

The Setup sub menu may be used to program the monitor's intervals and conditions. The monitor is
programmed in 24-hour segments, with the End Time for the last Period defaulting to the Period One
(1) Time that is both the Start and End Time for the monitoring session. Please also note that the
Periods must be defined consecutively, i.e. set Period 1 then Period 2, then Period 3, not Period 1
then Period 3. To program the monitor, follow the steps below:

Note: The monitor, interface, and cable must be connected to the computer correctly,
see "2-2 Communication Between the Monitor and the Program”.

Step1 Select the Recorder menu.

Step 2  Select Setup sub menu. The Recorder Setup dialog box appears.
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Recorder ID:
Time: ]21-_35
Date: --[03/31/39
r Recoider: ““”“*_”mm—‘*
: 1 Display ————— !
&0 cor |
[ &0n CoOF |
PERIOD  START HOUR INTERVAL
1 jo ﬁ 115 minutes ]
2 I B =l
L TR~ B =
I
oK | Cancel I Help I

Figure 19: TM-2420/TM-2421 Recorder Setup dialog box

Step 3 Select the Recorder ID field. Input a Recorder D number between 1 to 99.

Step 4 Select the Time field. Enter the current time. Use military time 1o set the clock. See
Figure 20.

15-min interval

Figure 20: Clock sefting example
7:00-21:59 15-min interval, 22:00-6:58 30-min interval

Step 5 Select the Display check box to set the display to ON or OFF.
Step 6 Select the Buzzer check box to set the buzzer ON or OFF.

Step 7 Select the Time field for Period One (1) and enter the time you want the monitoring
session to begin. Use military time to set the Time.

Note: The Time for Period One (1) also defines the End of the monitoring session 24
hours iater. See examples at the end of this section.
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Step 8
Step 9

Step 10

Step 11
Step 12

Step 13

Step 14
Step 15

Step 16

Step 17
Step 18

S_tep 19

Select the Interval drop-down menu for Period One (1) and set the measurement
Interval for Period One (1) to: OFF, 1, 2, 3, 5, 10, 15, 20°, 30, 60 or 120 minutes.

If you want to program a second period, go to step 10.
If you do not want to program a second period, go to step 18.

Select the Time field for Period Two (2) and enter the time you want for this period:
this will also set the end for period One (1). Use military time to set the Time. See
examples at the end of this section.

Select the Interval drop-down menu for Period Two (2) and set the measurement
Interval for Pericd Two (2) to: OFF, 1, 2, 3, 5, 10, 15, 20, 30, 60 or 120 minutes.

If you want to program a third period, go to step 13.
If you do not want to program a third period, go to step 18.

Select the Time field for Period Three (3) and enter the time you want for this period;

this will also set the end for period Two (2). Use military time to set the Time. See
exampies at the end of this section.

Select the Interval drop-down menu for Period Three (3} and set the measurement
Interval for Period Three (3} to: OFF, 1, 2, 3,5, 10, 15, 20, 30, 60 or 120 minutes.

if you want to program a fourth period, go to step 186.
If you do not want to program a fourth period, go to step 18.

Select the Time field for Period Four (4) and enter the time you want for this period;
the end period for Period Four (4) will be the Time for Period (1). Use military time to
set the Time. See examples at the end of this section.

Select the Interval drop-down menu for Period Four (4) and set the measurement
Interval for Period Four (4) to;: OFF, 1,2, 3, 5,10, 15, 20, 30, 60 or 120 minutes.

If the intervals are set correctly, select the OK button to confirm the programming. if
they are not correct, reset them, or go to step 19. -

To cancel the programming and close the Recorder—Setup dialog box, select the
Cancel button.

2-7-3-2 TM-2430 Series Setup
The recorder setup for the TM-2430 series is similar to the TM-2420/TM-2421 except that it includes
two additional optiohs for setting the BP measurement intervals as shown in Figure 21.

Description of each mode is as foliows:

Mode 1 07:00-21:59 The measurement is performed every 15 minutes.

22:00-06:59 The measurement is performed every 30 minutes.

Mode 2 The AUTO ON/OFF] key is pressed at rising and going to bed so that the measurement
intervals are changed and the time during sleep can be distinguished on the data.
When the "S” is off, the measurement is performed every 15 minutes.

When the “S” is displayed, the measurement is performed every 30 minutes.

Mode 3 The measurement interval can be changed six times within a maximum of 24 hours. (The

recorder can store six measurement intervals (periods) in 24 hours. A period consists of a
start time and frequency.)

5 The 20-minute Interval selection is available only with the TM-2421.
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2-7-3-3 Examples of Programming the Monitor

(A) Example: Programming the Monitor for One (1) Period

Suppose that the start time of the monitoring session is 09:00 and you would like the monitor to
measure the patient's blood pressure every 30 minutes. Remember that the Time for Period One (1)

also defines the End of the monitoring session. The end time for Period 1 will default to the Time for
Period One (1), in this case 09:00.

PERIOD TIME INTERVAL DURATION
1 09:00-09:00 30 minutes 24 hours
Total: 24 hours

The following is the monitor setup according to these instructions.

Note: Set Period One (1) only. Leave the other Periods blank.

PERIOD TIME ~ INTERVAL
1 [9 1 [30 minutes |
2 L | |OFF |
3 [ | [oFF ]
4 QFF
5 OFF
6 OFF
[ Recorder- Setup . ] f ]
Recoder D; [T Ve 72 Dats: IE‘mT
. R?;; P
i@ 8 O Mudel- 07009 200.15mn 22005 07.00, Bmin P
[COH ] D€ Mode2-  SeepbulonOFF, J5min Sieep betion DN, Mrin
T 7 G Mok3-  PERIOD STARTHOUR  INTERVAL
U
2 I+ JoF -
3 [T [eF =
i g o -~
5 ]_j OFF ~
8 T for -
& | e | we |

Figure 21: TM-2430 series Recorder-Setup dialog box
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(B) Example: Programming Monitor for Three (3) Periods

Suppose that the start time of the monitoring session is 09:00 and you would like the monitor to
measure the patient's blood pressure every 30 minutes until 22:00, and from 22:00 to 07:00 once an
hour, and from 07:00 you would like the blood pressure measured every 15 minutes. Remember that
the Time for Period One (1} also defines the End of the monitoring session. The end time for Period
Three (3) wili default to the Time for Period One (1), in this case 09:00.

PERIOD TIME INTERVAL DURATION

1 09:00-22:00 30 minutes 13 hours

2 22:00-07:00 1 hour 9 hours

3 07:00-09:00 15 minutes 2 hours
Total: 24 hours

The following is the monitor setup according to these instructions.

Note: Set Periods One (1), Two (2) and Three (3) only. Leave the other Periods blank.

PERIOD TIME INTERVAL

1 fo ~ | 130 minutes |
2 | 22 | |1 hour }
3 (7 | |15 minutes |
4 | | | OFF |
5 | | | OFF ]
6 | | | OFF |
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(C) Example: Programming Monitor for Four (4) Periods

Suppose that the start time of the monitoring session is 09:00 and you would like the monitor to
measure the patient's blood pressure every 30 minutes until 22:00, and from 22:00 to 23:00 you
want the monitor OFF so that the patient may sleep, and from 23:00 to 06:00 you would like the
patient's biood pressure measured once an hour, and finally from 06:00 you want the blood pressure
measured every 15 minutes. Remember that the Time for Period One (1) also defines the End of the
monitoring session. The end time for Period Four (4} will default to the Time for Period One (1), in

this case 09:00.

PERIOD

1

2

3

TIME
09:00-
22:00
22:00-
23:00
23:00-
06:00
06:00-
09:00

INTERVAL DURATION
30 minutes 13 hours
OFF 1 hours

1 hour 7 hours

15 minutes 3 hours
Total: 24 hours

The following is the monitor setup according to these instructions.

Note: Set Periods One (1), Two (2), Three {3) and Four (4). Leav; the other Periods

blank.

PERIOD

D O s W R =

TIME INTERVAL
E | | 30 minutes |
| 22 | 1 OFF |
| 23 | |1 hour |
[ 6 | | 15 minutes |
I | LOFF |
| | |OFF |
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2-8 Report Menu

Custom report formats may be saved for future use through the Report menu. The following
functions are available in the Report dialog box:

Create a new report tempiate

Edit an existing report template

Delete an existing report template

Save an existing template as the default report style
Print a user defined report

Print a “Mini" report

* & & ¢ & o o

Close the Report dialog box

Report E3 l

Fullt Korotkoff - Oscillometric
Fult Oscillometric
Full Decillometric - Korotkoff
Edit...
Delete
LClose
Save as default report Frivt repot Print “Mini" report

Figure 22: Report dialog box

To open the Report dialog box, print a report, create a new report template or edit an existing
template, click the Report menu on the main menu.

2-8-1 Creating a New Report Template

Step 1 Click the New button on the Report dialog box. The New Report dialog box will
appear.

Step 2 Type the Report Name.

Step 3 Edit the Report Heading. This heading will appear on the top of every page along
with the file name and time the file is printed.

Step 4 Select the Text Data you want included in the report by checking the appropriate
boxes.

Note: You may check all or none of these boxes. An unchecked box will not print; a
checked box will print.
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Step 5 Select the Graphical Data you want included in the report by checking the
appropriate boxes.

Note: You can check all or none of these boxes. An unchecked box will not print; a
checked box will print,

Step 6 Select the Measurement Method to base the report on by selecting the appropriate
radio button.

Step 7 Save the report template by selecting the Save button.
Step 8 If you do not want to save the report template, select the Cancel button.

2-8-2 Editing an Existing Report Template

ﬁ Beport Setup

RBeport Name; ’

Report Heading: .IA&D ABPM ANALYSIS REPORT

- TextData - BP Mode
[~ Patient information | & Oscilometric only
I~ Summary data . € 1:0scillometiic, 2K orotkoff
I” BPdata = Korotkoff only

"~ 1:Karotkoff, 2:Oscillometric

- Graphical Data
I~ Blood pressure
I~ Double product

™ Conelation Save I Cancel I

™ Histograms

PR

Figure 23: New Report Tempiate dialog box

Step 1 Highlight the report template you want to edit.
Step 2 Click the Edit button.
Step 3 Edit the Report Name.

Step 4 Edit the Report Heading. The Report Heading will appear on the top of every page
along with the file name and time the file printed.

Step 5 Edit the selected Text Data you want included in the report by checking or
unchecking the appropriate boxes.

Note: You may check all or none of these boxes. An unchecked box will not print; a
checked a box will print.

Step 6 Edit the selected Graphical Data you want included in the report by checking or
unchecking the appropriate boxes.

Note: You may check alf or none of these boxes. An unchecked box will not print; a
checked box will print.

Step 7 Edit the selected Measurement Method to base the report on by checking or
unchecking the appropriate radio button.

Step 8 Save the report template by selecting the Save button.
Step 9  If you do not want to save the report template, seiect the Cancel button.

39



2-8-3 Deleting an Existing Report Template
Step 1 Highlight the report template you want to delete in the Report dialog box.
Step 2 Select the Delete button.
Step 3 Confirm deletion of the specified report format by selecting the OK button.
Step 4 To cancel this operation, select the Cancel button.

2-8-4 Saving a Default Report Template for Printing
Step 1 Highlight the report template you want to save as the default report.

Step 2 Select the Save As Default Report button. The specified report template will be saved
as the default report.

2-8-5 Printing an Existing Report Template
Step 1 Select the Print Report button to print the Default Report Template. If you want to
print a report template other than the Default Report Template, go to the next step.

Step 2 Highlight the desired report template in the Report dialog box.

Step3 Select the Print Report button. The report will print.

2-8-6 Closing the Report dialog box
Step 1 Select the Close button.

2-9 Options Menu

The Options menu may be used to access default and various formatting screens within the program.
The foliowing Options features are available:

Menu See Description

Report Formats | “2-8 Report Menu” The Report formats may be used to create and
save custom report formats.

Physicians List | “2-9-2 Physician List” The Physicians list may be used to store contact
information on the patient’s physician, i.e. address
and phone number, so that the Physician fields in
the Patient Information screen may be quickly

updated.
Trend Display “2-6-3-3 Trend Display: | The Trend display may be used to customize the
Positioning Trends” Trends screen,

Default Settings | “2-9-4 Default Settings” | There are two defauit settings:

1} BP settings (Blood Pressure settings) which may
be used to set the default BP mode and BP
limits.

2) Serial port which may be used to set the
communication port for interfacing with the
monitor,
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2-9-1 Report formats
See “2-8 Report Menu™.

2-9-2 Physician List
The Physicians List is used to store contact information for multiple physicians. This will save time
from repetitive data input.

Phystcian List E3 l

Becker. Jerry

Figure 24: Physician List dialog box

Step1 Select the Options menu.
Step 2 Select the Physician List sub menu.

The foilowing instructions outline the various Physician List features available.

2-9-2-1 Adding a New Physician to the List

Physician Entry . ’
Fist name: I
Save
Last name: I
Address: Cancel
Phone; I

Figure 25: New Physician Entry dialog box

Step 1 Select the New button on the Physician List dialog box.
Step 2 Enter the appropriate data.
Note: All fields must be completed.

Step 3 Save the new physician tempiate in the list by selecting the Save button.
If you do not want to save the new physician, select the Cancel button.
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2-9-2- 2 Editing an Existing Physician in the List

Step 1
Step 2
Step 3

Highlight the physician’s name you want to edit.
Select the Edit button.
Select the field to edit and then type the new data.

Note: All fields must be completed.

Step 4

Save the edited physician template by selecting the Save button.
If you do not want to save the edited physician, select the Cancel button.

2-9-2-3 Deleting an Existing Physician in the List

Step 1
Step 2
Step 3
Step 4

Highlight the physician’'s name you want to delete.

Select the Delete button.

Confirm deletion of the specified physician template by selecting the OK button.
If you do not want to delete the physician template, select the Cancel button.

2-9-3 Trend Display
See “2-6-3-3 Trend Display: Positioning Trends”.

2-9-4 Default Settings

There are three default settings in this program:

1} Blood Pressure
2) Serial Port
3} Recorder Type

2-9-4-1 BP (Blood Pressure) Settings
Edit the Default Blood Pressure Settings as follows:

Step 1
Step 2

Step 3
Step 4

-

Select the Measurement Method (BP Mode).
Enter data for each value. The following is the description of each value.
Systolic Limit;

The percentage of readings exceeding the specified Systolic limit for the Awake and

Sleep interval will be calculated and noted both on the Summary Data tabs and
printed reports,

Diastolic Limnit;

The percentage of readings exceeding the specified Diastolic limit for the Awake and

Sleep interval will be calculated and noted both on the Summary Data tabs and
printed reports.

To save the edits, select the Save button.

To cancel the edits, select the Caneel button.
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Default Blood Pressure Settings I

- MeasUrement Method —

[y -. d#&iilbhiétﬁc only

™ 1:Dscillometric, 2-Kosotkoff
¢ Korotkoff only

o 1:Korotkoft, 2:0scillometric

HYPERTEMNSIVE LIMITS
 Awake Interval - Sleep interval

Systolic limit; ]W mmHg i Systalic limit: {120 mmHg
i
<;
i

Diastolic Fmit; ]50 mmHg

Diastolic kmit: {7g mmHg

Lancel Help I

Figure 26 Default Blood Pressure Setfings dialog box

2-9-4-2 Serial Port
The serial port is used to communicate between the monitor and the computer. The serial port
setting and the port used for communication must be the same.

Default Serial Port Selection ‘
- Setial Port
" Gomt -

' Cpmg
T Comd

£ Copd

Cancel l

Figure 27: Default Serial Fort Sefection dialog box
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2-9-4- 3 Recorder Type

Recorder Type i

- Sele;_:_tibn —
O TM24217TM2420
& TM2430

Save !

Figure 28: Default Recorder Type dialog box

The default Recorder Type function is used to select the type of monitor the program will

communicate with for all Recorder functions. This function does not affect which type of data files the
program can analyze.

2-10 On-line Help

Help screens are available for on-line program assistance. There are three ways to access the Help
function.

1} Select the Help menu on the Menu bar.

2) Click Help buttons which appear on various dialog boxes throughout the program.
3) Press the F1 key at any point during the operation of the program.
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| 3. TROUBLE SHOOTING

3-1 Measurement Errors

The following tables list the error messages that may occur during a monitoring session and offer
information on possible causes and corrections.

3-1-1 TM-2420/TM-2421 Error Codes

ERROR CODE POSSIBLE CAUSE CORRECTION

EO1 The microphone has become | Remove and reconnect the microphone
disconnected or there has been | connector at the front of the monitor.
excessive body motion.

E02 Air leak Check that the air hose plug is tightly
connected to the air connector located
at the front of the monitor.

Check the connection between the air
hose plugs and the air biadder.
Check the air bladder for leaks.
EO04 Low Battery, “c”, shown in the|Plug the AC adapter in the monitor.
monitor display. The “c” shown on the display will
The monitor will not take a|disappear after 30 minutes. Wait the {full
measurement, print data, or |60 minutes charging time to ensure that
download data until the monitor is | the battery is fully charged.
charged. Note: The monitor wilt-hold all stored
readings in memory for two weeks after
the appearance of the fow battery
indicator.
EO05 Measurement time exceeds 100{Check EO1 and EO02 procedures.
seconds. Reposition the lower microphone and
{Inflation time error) then correlate it to the subject.
Check that the air hose is not held down
- by a constrictive strap or similar
: restraint which may disrupt the air flow.
E06 Pressurization greater than 320

mmHg

Confirm that the subject is not moving
during the measurement.

Clear the memory.
Caution: All measurement data will beg
erased.

After clearing the memory, take ong
measurement. If the cuff pressurizes tg
approximately 195 mmHg, the system ig
OK.

Reset the monitor by gently inserting 4
paper clip in the hole located on thg
bottom of the monitor.

Caution: All measurement data, ag
well as programmed intervals and
conditions will be erased.

If the monitor stops and then continues
to inflate above 260 mmHg, return the
unit to A&D for service.
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ERROR CODE POSSIBLE CAUSE CORRECTION

E07 Manual stop The measurement was manually
interrupted by depression of the red
Start/Stop button.

EO08 Korotkoff sounds are | Check that the microphone is affixed |

undetectable. with the sensing side (skin side) facing
the patient's arm.
Note: The microphone should always
be taped to the arm with the supplied
affixing tape. Place "X" of tape over the
top of it.

E11 More than 256 Korotkoff sounds | Check for a break in the microphone
are measured. lead. Check for external damage to the

microphone. Microphone circuit may be
damaged.
Note: If a break in the microphone lead
or external damage has occurred, the
microphone  Assembly  must be
replaced.

E20 Pulse Error Check the position of the lower
Pulse less than 35 beats or more | microphone and then re-correlate it to
than 200 beats per minute. the subject.

Note: Certain physiological conditions
or pharmaceutical treatment may
excessively reduce or increase a pulse
rate. In cases of excessively low puise
rates, have the subject walk or stand a
few minutes to raise the pulse rate
above 35 beats per minute.

E21 Diastolic greater than 160 mmHg | Outside of normal physiological
or less than 40 mmHg. parameters.

E22 Systolic greater than 280 mmHg | Outside of normal physiological
or less than 60 mmHg. parameters.

E23 Systolic minus diastolic less than | Quiside of normal physiciogical
10 mmHg. parameters.

E24 Systolic minus diastolic greater

than 150 mmHg.

Confirm that the subject is not moving
during measurement.  Reposition the
lower microphone and then correlate it tg
the subject.

Note: If a2 measurement error occurs (other than £08) when the “Auto” mode is set, the
monitor will automatically take a 2nd measurement. If a second measurement
error occurs, a 3rd measurement will not be taken. The monitor will return to its
programmed interval,
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3-1-2 TM-2430 Series Error Codes

ERROR CODE POSSIBLE CAUSE CORRECTION

EO0D All parameters are lost. Enter clock parameters.

EO03 An error code is displayed | Exhaustthe air from the cuff completely.

without cuff inflation.

E04 Measurement is stopped due to | Replace with new batteries. Auto mode

the low battery. is quit. Restart the Auto mode if you use
it.

EDS Inflation pressure does not reach | Wrap the cuff and connect to the

the target pressure. monittor. If the error persists, there may
be an air leak and repair is necessary.

EO6 Pressurization greater than 320 | Do not move and try to refax during the

mmHg. measurement. If you can not clear the
error, repair is necessary.

EO7 Controlled stop using STOP key |[Do not press the STOP key when
unnecessary.

E08, E10 Pulse can not be detected. Do not move and try to relax during the
measurement.

E20 Pulse rate<30, 200<pulse raie Measure the blood pressure by other
methods.

E21 DiA<40, 160<DIA Measure the blood pressure by other
methods.

E22 SYS<60, 280<5SYS Measure the blood pressure by other
methods.

E23 DSD<10, 150<DSD Measure the blood pressure by other

{DSD=difference between methods.
systolic blood pressure and
diastolic blood pressure)

E30, E31 Air is exhausted form the cufi. Repair is necessary.

E32 Clock error if the error persists, repair is necessary.

E50 Pressure offset error Repair is necessary,

E52 Memory error Repair is necessary.

ES53 Defective battery contact Replace batteries correctly. If the error
persists, repair is necessary.

ES5, ESB, ERT Exhaust error Relax and do not move during the
measurement. If this error occurs
frequently, repair is necessary.

E60 Interval setting error Enter the interval parameters correctly.

E70,71,72,73 RS-232C error Re-connect the communication cable. I
the error persists, repair is necessary.

E74 Voltage decreases during | Replace batteries with new ones and

communication. restart communication.

E75 Protocol error due to external | Re-connect the communication cable. If

equipment the error persists, repair is necessary.
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3-2 Communication Errors

When communicating between the monitor and the PC, the following dialog box may appear if the
communication setup is not performed properly:

Error l

r

s . .
J ! Recorder not responding. Check cable and recorder connection.

Figure 29: Communications Error dialog box

If this error occurs, complete the steps below:
Step1 Select the OK button on the Error dialog box.

Step2 Check the monitor's Low battery. R'echarge the battery if necessary. Or replace with
new batteries.

Step 3 Check the Default Serial Port selection. Make sure it is correct.
Step 4 Check the Default Recorder Type selection.
Step 5 Disconnect the monitor from the processor and reconnect them.

Step 6 Attempt communication. You may need to go through the process a few times to re-
establish communication.

If the error still persists, complete the steps below:
Step 1 Exit the program.

Step 2 Disconnect the monitor from the processor and then reconnect them.
Step 3 Charge the monitor's battery.
Step 5 Start the program.

Step 6 Check the Default Serial Port selection. Make sure it is correct.
Step 7 Check the Safest Recorder Type selection.

Step 8 Attempt communication again.

3-3 Missing Files

If you can not find your files in one of the File menu screens, and the files have not been deleted,
there are two possible causes:

The .dat file was relocated to another location on the hard drive without moving its corresponding .P
file. Check that both the .dat and .P files are in the same directory. The .P file was relocated to

another location on the hard drive without moving its corresponding .dat file. Check that both
the .dat and .P files are in the same directory.
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3-4 Reports Are Not Printing With the Desired BP Mode

Itis important to note that the toolbar BP Mode and Default BP Mode settings are separate from the
Report Format BP Mode settings. The BP Mode defined in the toolbar is not necessarily the BP
Mode that will be used for the printed report. For information on how to set the BP Mode for the
printed report, see "2-8-1-2 Editing an Existing Report Template”.

Lit Report Setup [ |

Repart Name; i

Report Heading: !A&D ABPM ANALYSIS REPORT

= Text Data - - BP Mode d
I~ Patient information i@ Oscillometric only E
(1 Summary data ™ 1:0scillometric, 2Korotkoff !
(] BPdata | © KorotkoHf onp E
: E € 1:Korotkoff, 2:Dscilomelic
= Graphical Data

{™ Blood pressure

I Double product

: T~ Conelation ; Save Lancel

. ™ Histograms !

Figure 30: Report Setup dialog box

3-5 Summary Data / Sleep Tab Data can not be Seen

Make sure that the Sleep parameters in the Patient Information screen are within the monitoring
sessions time. For example, this problem may oceur if the monitoring session began at 11:30, but
the Sleep Beg_inc time was set at 11:25. Reset the Sleep begin time so that it falls within the
monitoring session's times.
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